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 Affiliate Marketing
 Start Up Program
 Hello Student!
 Congratulations on seizing a unique and remarkable opportunity.
 You are about to embark on a life changing journey that can - if you want it to,
 change your life & the way you look at the internet in general forever.
 You hold in your possession a program of great knowledge and your about to learn
 things that some big corporations and businesses have no idea about.
 Its fun being a part of the minority and although thousands of people know about
 some of this knowledge there are still BILLIONS out there who don’t have a clue.
 In this program you will learn:
 1. How to register a domain - A Domain is.....................click here for more info
 2. How to host websites - Web Hosting is.......................click here for more info
 3. How to use autoresponders - Autoresponder is.....click here for more info
 4. How squeeze pages work - Squeeze Page is..........click here for more info
 5. How to use google adwords - Google Adwords.....click here for more info
 6. How to setup wordpress blogs – A blog is................click here for more info
 That’s just some basic things, all this info put together in the right format and order,
 mixed together with business, sales and people gives birth to Affiliate Marketing.
 For this program you will need Paypal / Credit Card & approx $35, start up costs.
 I wish you every success in your ventures and hope to see you soon on the other
 side.
 To Your Success
 *******************
 Regards
 John Regis
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 Affiliate Program Content
 Exercise 1 - Getting Started
 1. Signing Up For Your Domain Account.....................................................................................2
 2. Registering Your Domain................................................................................................................5
 Exercise 2 - Hosting
 1. Creating You Hosting Account..................................................................................................12
 2. Changing The Name Servers Of Your Domain.................................................................15
 3. Adding A Domain To Your Hosting Account......................................................................17
 4. Setting Up Email Forwarding Using Your Domain Control Panel...........................18
 Exercise 3 - Affiliating
 1. Choosing A Click Bank Product & Creating The Affiliate Link Code....................19
 Exercise 4 - Autoresponder & Opt-ins
 1. Creating an Autoresponder.........................................................................................................24
 2. Turning off Opt-in Verification...................................................................................................28
 3. Creating an Opt-in Form...............................................................................................................29
 Exercise 5 - Squeezing
 1. Creating Your Opt-in Page..........................................................................................................32
 2. Uploading Your Page Using Control Panel.........................................................................36
 Exercise 6 - Traffic Secrets
 1. Creating Your Google Adwords Account............................................................................38
 2. Setting Up Google Adwords Campaign................................................................................43
 3. Optimizing Your Adwords Campaign (Split Testing, Keyword Tool).....................45
 Exercise 7 - Traffic Secrets Advanced
 1. Installing A Wordpress Blog On Your Website.................................................................54 2. Creating Your First Blog Post.....................................................................................................56
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 Getting Started:
 Signing Up For Your Domain Account
 1. Open your browser and go to
 http://yourInternetmarketingexpert.com/links, save this in your favourites or
 bookmarks. From here click on the Doman Registration & Nameserver link
 2. Next Click Create Account as shown below
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 3. Fill in the form with all the required information and remember to input your
 Login Name & Password into your Y.I.M.E password sheet.
 4. Choose Personal in the account type option.
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 5. I would advise you choose No to all the GoDaddy promotions as i have
 highlighted below.
 6. Click Create New Account
 NOTE: If you forget for any reason to fill out any of the fields, GoDaddy will revert
 you back to the order page to fill in the missing fields. GoDaddy will also
 automatically check ALL the fields above to YES, so remember to choose NO on
 all of them and double check all your fields have been filled out correctly before
 Proceeding further
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 Getting Started:
 Registering Your Domain
 1. Enter a domain name you require into the Domain Name Search box and click GO!
 2. If the domain you have selected is available, it will appear as below with a
 green tick beside the domain name. If you have this great news for you, now
 proceed to checkout.
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 3. In most cases, your primary choice may already be taken. If so it will appear
 with a red cross like below.
 4. You can scroll down to locate what alternative domain names that are
 available is being offered to you by GoDaddy. Choose a domain and click
 Proceed to Checkout.
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 5. As with most companies they will often try to up sell extra services or product
 to you, so i advise you decline any of these and proceed straight to checkout.
 Just click No Thanks in the next screen as shown below.
 6. Sometimes at this point you might be asked to log back in, but this does not
 always happen. If it does just choose to Login to Existing Account, fill in your
 Login details and click secure login.
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 7. Select 1year from the drop down menu in Domain Registration Preferences and
 click to change the renewal to manual.
 8. Next scroll down to the bottom of the screen, ignoring anything else and click
 to Continue.
 9. On the shopping cart review page enter AMAZON2 as the promo code and
 select apply code.
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 10. Next, Select Your Payment Method and tick the 2 boxes Universal Terms &
 Conditions and Domain Registration Agreement. Then click Checkout Now. To
 use your PAYPAL account, select the option, then click Continue Checkout and
 go to Page 10 in this program. PLEASE DONT NOT SELECT PAYPAL IF YOU DO
 NOT ALREADY HAVE AN ACCOUNT AS YOU WILL NOT COMPLETE TRANSACTION
 TODAY, YOU CAN ADD PAYPAL AS A PAYMENT METHOD LATER
 11. Complete the payment information as seen below and click Checkout Now.
 Finally enter the code to verify your order
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 12. Fill in your PayPal login details and click Log In, then on the next page click I
 Agree & Continue.
 13. You will then have successfully created a payment agreement as shown
 below; you can now click Continue to GoDaddy.com Inc Button.
 14. On returning to GoDaddy, click the Continue With Checkout button

Page 12
						

www.YourInternetMarketingExpert.com – Affiliate Marketing Program
 __________________________________________________________________________________________
 __________________________________________________________________________________________
 Page | 12 – ©John Regis and www.YourInternetMarketingExpert.com – Affiliate Marketing Program
 15. Finally, click Place Your Order ‘Only Once’ and enter the code when prompted
 to verify your order.
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 Hosting
 Creating Your Hosting Account
 1. Open your browser and enter:
 http://www.YourInternetMarketingExpert.com/links and select the Domain &
 Web Hosting Link.
 2. You will see 3 different package options as seen below, choose the hosting
 option.

Page 14
						

www.YourInternetMarketingExpert.com – Affiliate Marketing Program
 __________________________________________________________________________________________
 __________________________________________________________________________________________
 Page | 14 – ©John Regis and www.YourInternetMarketingExpert.com – Affiliate Marketing Program
 3. Click the option to Register New Domain. Input your domain name, Try to
 Register YourOwnName.com (where YourOwnName is replaced with your
 own name). Click next.
 4. If the domain name is available Click Continue. Otherwise go back and choose
 a different domain.
 5. In the next window select the baby package, your domain should already be
 pre-selected.
 6. Next select your billing cycle, It is your choice which one you choose but the
 longer the period the cheaper it gets, Then click Calculate Totals.
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 7. On the next screen, check the summary and select I Am A New Customer and
 click Continue.
 8. On the next screen, complete your personal information and make sure you
 write down your Username & Password on the Password Sheet provided,
 complete your payment details and click Verify My Order.
 9. Then in the next window click Process My Order. Once completed within the
 next 20mins you should have 2 from [email protected]. Write down the
 name servers on your password sheet
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 Hosting
 Changing The Name Servers Of Your Domain
 1. Open your browser and go to http://www.yourinternetmarketingexpert.com/links
 Then select the Domain Registration & Nameserver link.
 2. Depending on if you are still signed in, complete your log in information from
 your password sheet and click the GO button.
 3. Click the Domain tab then select My Domains from the drop down menu.
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 4. Then select the check box next to your domain (you will only have one at this
 point) and then click the Nameservers link.
 5. Select the I host my domains elsewhere tab then from your Password Sheet
 copy the name servers into the correct windows as shown below, then click OK.
 6. In the next screen you will confirmation of your actions, so just click OK to
 confirm.
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 Hosting
 Adding A Domain To Your Hosting
 1. Ensure you have already set the nameservers for your new domain to the
 values sent by hostgator (they will be on your password sheet).
 2. Login to your hostgator account by going to the following URL:
 http://www.YourDomainName.com/cpanel, replace YourDomainName with the
 domain name you have registered with hostgator (preferably your own name).
 3. Login with your Username & Password from your Password Sheet.
 4. Scroll down to the domains area and click Add Domains.
 5. Fill in the details below and then click Add Domain.
 6. You now completed adding your domain; you can add an UNLIMITED amount of
 domains to your hostgator account providing you do not exceed your bandwidth
 or allocated space.
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 Hosting
 Setting Up Email Forwarding In Cpanel
 1. Open your web page and go to http://www.yourdomainname.com/cpanel. Enter
 your login details as on your password sheet when prompted.
 2. Next go down to Mail and click on the Forwarders tab in this section.
 3. Next click to Add Forwarder tab.
 4. Use [email protected] and then input an existing email address you
 want the mail to be forwarded to in the Forward To Existing Email Box circled
 below, then click Add Forwarder.
 5. You will then go to the confirmation screen and that’s it.
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 Affiliate Links
 Choosing An Affiliate Product & Creating The Link Code
 1. Open your web browser and got to
 http://www.yourinternetmarketingexpert.com/links and select Affiliate
 Marketplace.
 2. Next click on the sign up tab at the top off the screen as shown below.
 3. Complete the form information and select an Account Name, which your
 customers will see and will also identify you as an affiliate on Clickbank.
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 4. Next you will see a screen as shown below.
 5. Go to your email to find your Confirmation Code email from click bank, open it
 and note the confirmation code, click the link that’s shown here.
 6. Next input the required information and click finish.
 7. Enter the information in the next page into your Password Sheet.
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 8. Next at the top of the screen click on the Marketplace tab.
 In the Category: field, choose your category. If you are unsure, leave it set to
 all categories
 In the Keywords: field, input the name of your niche or keywords of your
 niche.
 In the sort by window, select High Gravity
 Then click Go.
 9. From your search results, pay attention to the numbers on the third line as
 shown below, you want tone that has quite a high gravity, but also pays you a
 good amount from each sale. Select your product by clicking the Create Hop
 link tab under which ever product you wish to promote. If you would like to see
 the page you will be promoting, click the view pitch page.
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 10. In the window that pops up, input your ClickBank Nickname from your password
 sheet and click Create, Tracking ID is optional but you need not worry about
 this.
 11. Select the line as show below right click on it and select copy. Then click close
 window.
 12. Go to your desktop, Right-click and select New > Text Document, this will
 create a new text file called New Text Document.
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 13. Double click on this and select the Edit tab, then select Paste to copy your Hop
 Link code into this file.
 14. Next click the File tab then select Exit.
 15. You will asked to save the file, select yes and save it to its original location (the
 desktop) You are now ready to use this link in the next section when we will
 create a web form for our opt in page.
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 Autoresponder & Optin’s
 Creating An Autoresponder
 1. Open your web browser and go to
 http://www.yourinternetmarketingexpert.com/links and select Autoresponder &
 Opt In Forms.
 2. On the right hand side of the page select Start Now button.
 3. In the next screen select the AR Package and click Get Started Now. It is
 important to use this package as the Free package is very limited and will not
 allow you to do various things which we will need. Taking into account the
 exchange rate it’s not expensive at all.
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 4. Next complete your details using www.YourDomain.com for the URL field. The
 entire form must be filled out. Then Click Continue
 5. Fill in your billing information then select Click Here To Confirm.
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 6. From the congratulations page, copy your Merchant ID & into your Password
 Sheet. You can enter the password but in pencil as you will change this now...
 Then click Proceed To Your Account.
 7. You will be prompted to provide your own New Password, when done enter this
 Password into the password sheet. Click Change Password and continue to the
 Home Screen.
 8. From the menu tab hover over Email & Marketing > Autoresponder then select
 Create Autoresponder.
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 9. Complete the fields as shown below.
 10. This will direct you to the next step where you can write your first message,
 take time to look at the image below to familiarise yourself with the required
 step.
 To insert one of the special merge code values just type them
 %$firstname$% for example.
 *Be sure to set Days Delay to “0” so this message will be sent immediately,
 Following message can be sent e.g. on day 4, 8, 12.... etc.
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 Autoresponder & Optin’s
 Turning off Opt-in Verification
 1. Select Email & Marketing > Opt-in Preferences
 2. In the screen that loads, select the following settings in the Verified Opt-in
 Default settings:
 1- Require Opt-in Verification for webform submissions to NO
 2- Click Save Settings to confirm
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 Autoresponder & Optin’s
 Creating An Opt-in Form
 1. Log into your TotalBusinessCart account. Select Email & Marketing > Custom
 Forms > Create Form.
 2. Leave all the settings as they are you don’t need to change anything here right
 now. Scroll down and click Next Step.
 NOTE: Default settings selected a form with just Name & Email inputs.
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 3. In the next screen, change the following settings:
 1- The “Thank you URL” value to your ClickBank hop link URL from the text file
 saved on your desktop, completed in Exercise 3.
 2- Select your previously created Auto Responder you completed in Exercise 4.1
 from the drop down menu which you called Test Auto R.
 3- Click Create Form.
 4. You will then be directed to the next screen where your Form for your opt-in
 page will be created in HTML Code. Seen as we don’t have the opt-in page yet,
 we will store this information in our textfile on the desktop. Click the “Select All”
 link as show in the image below.
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 5. Right Click inside the fully selected text and choose ‘Copy’ from the drop down
 menu.
 6. Go to your desktop. Double click on the textfile your previously created to open
 it, then click Edit > Paste.
 This will paste your form code into the file, you can now save and close the
 textfile and logout of your TotalBusinessCart account.
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 Squeezing
 Creating Your Opt-in Page
 1. Open your browser and go to
 http://www.yourinternetmarketingexpert.com/links , click on the Opt In link as
 show below. This will direct you to a free opt-in page generator donated by
 my mentor and colleague Daniel Wagner (this software is for you only and
 should not be shared with anyone else).
 2. Next fill in steps from 1 – 16 to achieve the result shown on the next page. (Use
 the information from the pitch page of your promoted ClickBank product to help
 give you some inspiration).
 1- Site Title
 2- Site Description
 3- Keyword Phrase 1 (optional)
 4- Keyword Phrase 2 (optional)
 5- Keyword Phrase 3 (optional)
 6- Main Headline
 7- Sub Headline
 8- Video or image embed code
 9- Bullet point # 1
 10- Bullet point # 2
 11- Bullet point # 3
 12- Bullet point # 4 (optional)
 13- Bullet point # 5 (optional)
 14- TotalBusinessCart form code
 Open your textfile document on your desktop, Right Click the inside
 the box – click “Select All”, then Right Click again and select Copy
 15- Business Name = www.YourDomain.com
 16- Site Map (optional)
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 3. You can preview the page by pressing the Preview button, make any changes by
 go back pressing the Previous Step button. Once you are happy with your
 outcome, select Save as HTML.
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 4. If a warning about “page not saving correctly” appears, just click yes to
 continue.
 5. If you were given the option to name the file before saving as below shows,
 call it “index”, otherwise accept the default name “opt in”, then go to your
 desktop Right Click on the saved file and rename it to “index”.
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 Squeezing
 Uploading Your Opt-in Page
 1. Open your web browser and enter http://www.YourDomain.com/cpanel in the
 address bar. If the login box appears, enter your Hostgator Username &
 Password from your password sheet and click OK.
 2. Select File Manager
 3. Next a box should open with Document Root for: already pre-selected, if not
 select it then from the drop down menu choose your domain then click GO.
 This should direct you into your domain folder.
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 4. In your domain folder click the Upload button at the top of the screen, as
 shown below.
 5. Click the Browse button, locate your file “index” you saved earlier then click
 Open and your file will upload automatically.
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 6. Next open your web browser and type www.YourDomain.com to see your
 squeeze page: CONGRATULATIONS
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 Traffic Secrets
 Creating Your Google Adwords Account
 1. Open your web browser and go to
 http://www.yourinternetmarketingexpert.com/links and click on the Google
 Adwords link or image.
 2. Choose English (UK) and select Try Adwords now>>
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 3. Select the Standard Edition and then click Continue >>
 4. If you have any Google accounts and wish to use it with Google Adwords
 then > CLICK HERE <.
 *If you don’t hold any Google accounts or wish to create a new account for
 adwords, then select “I Do Not Use These Other Services” and enter your
 new account information Username & Password as shown below.
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 5. You will be direct back to the log in screen, enter your new login details and
 click Continue. (remember to enter them in your password sheet too)
 A confirmation email will be sent to the email address you provided and your AdWords account will be created.
 6. Go to your email account, locate the email from Google (check spam folder)
 and click on the link to verify your account as shown below.
 7. In the next window click the Manage Account Profile button, then click on the
 Adwords link in the bottom right corner, after you enter your log in details in
 the next window, click Continue.
 8. After you have clicked continue and Adwords loads > Click Here <

Page 42
						

www.YourInternetMarketingExpert.com – Affiliate Marketing Program
 __________________________________________________________________________________________
 __________________________________________________________________________________________
 Page | 42 – ©John Regis and www.YourInternetMarketingExpert.com – Affiliate Marketing Program
 CONT HERE IF YOU ALREADY HAVE GOOGLE ACCOUNT YOU WISH TO USE
 9. Copy the form as shown below, select that you have an account already and
 wish to use this account with Google Adwords.
 10. Fill in you previous details and click Continue. (Be sure to enter them in your
 password sheet).
 11. On the screen that loads, choose to Submit Your Payment Details. Your Ads
 will not run if this is not set up.
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 12. In next screen fill in your appropriate details the click Continue.
 13. Choose your billing method, I personal use Postpay but it’s up to you.
 14. In the next screen Accept the Terms & Conditions and then click Continue.
 15. Finally enter you billing details and click Save and Continue.
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 Traffic Secrets
 Setting Up A Google Adwords Campaign
 1. Open your web browser and go to
 http://www.yourinternetmarketingexpert.com/links and click on the Google
 Adwords link or image.
 2. Then sign in with your Username and Password.
 3. Click on the Campaign Summary tab and then click +New Online Campaign >
 Start With Keywords.
 4. Select English as your language here the click the Change Targeting link.
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 5. In this box click the Bundles tab at the top and choose your target locations to
 determine where you want your ad to appear, click Done when you are happy
 with your selections. Then click Continue in the previous window.
 6. You can now create your own Google Ad, use the example below as a guideline,
 using your own domain and niche area.
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 7. Next choose some common keywords associated with your niche/product your
 promoting. We will go into greater detail with keywords in a later exercise.
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 8. Enter a daily budget of $10 or equivalent and enter a maximum cost per click
 (CPC) of $0.10 – $0.20. Then click Continue >.
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 9. Review all your settings, then click Save Campaign.
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 Traffic Secrets
 Optimizing Your Google Adwords Campaign
 1. Next click on the Edit Campaign Settings link, as shown below.
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 2. Edit this page as shown below, you can decrease the Budget if you wish but i
 would not recommend you go below $5. Then click Save Changes.
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 3. Next, select Ad Group #1 as shown below.
 4. From the 4 tabs on the right hand side, click Ad Variations.
 5. Then click the Text Ad link as shown below.
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 6. Change 1 thing in this section, for example the Headline then click Save Ad.
 7. We now have 2 adverts being shown by Google on an alternating program,
 which means overtime we will be able to see which of the 2 adverts are doing
 better which will help us improve our campaign.
 8. Next click the Keywords tab on the right, Then click Keyword Tool link

Page 53
						

www.YourInternetMarketingExpert.com – Affiliate Marketing Program
 __________________________________________________________________________________________
 __________________________________________________________________________________________
 Page | 53 – ©John Regis and www.YourInternetMarketingExpert.com – Affiliate Marketing Program
 9. One of my favourite shortcuts to get some great keyword is to let Google spy on
 a competitor’s website. In this case, I did a Google search on Bowling Strikes,
 then put in the url of the top ranking ad. Click Get Keywords Ideas.
 10. From the results, select what you deem to be niche specific keywords by
 clicking the Add link on the right hand side. Note: Ideally you want mid – low
 Advertiser Competition & high Search Volumes, high Advertiser Competition
 means there’s lots of ads using that keyword.
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 11. Once you have added your keyword, click Save Ad Group on the right.
 12. If your campaign is active and your billing details have been enter correctly,
 you should find your ad within a few minutes searching in Google using the
 keywords you chose.
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 Traffic Secrets Advanced
 Installing A Wordpress Blog
 On Your Website
 1. Open your browser and go to www.YourDomain.com/cpanel. Login with the
 required information. Once on the homepage, scroll down to Software/Services
 as shown below and click on the Fantastico De Luxe link with the smiley face.
 2. From the list on the left hand side, click on Wordpress. Then select New
 Installation.
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 3. Fill in the required information, Click Install Wordpress.
 4. Next click Finish Installation.
 5. Finally, take note of your login details & url for the admin console o your blog
 (Password Sheet). Then click your blog admin link and go on to next Exercise.
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 Traffic Secrets
 Creating Your First Blog Post
 1. Go to www.YourDoamin.com/blog/wp-admin if you are not already there and log
 in. If this is your personal PC you can choose Remember Me.
 2. This will load you into the Dashboard (The main wordpress admin page); from
 here click the small arrow by Post to reveal a drop down menu. Select Add New
 from here.
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 3. Give your post a Title and put some Content into the post. Follow steps below.
 4. Congratulations on completing you First Blog Post!
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 .
 The End
 Affiliate Program Debrief
 Congratulations! on completing your Affiliate Marketing Program.
 I hope you have had as much fun learning as I did writing this program.
 I would like to take this opportunity to tell you about our after program support
 website program.
 John Regis’s “Your Internet Marketing Expert” website is the continuation that
 supplements all you have learned on the “Affiliate Start Up Program” which is
 just the tip of the iceberg.
 I know you must be bursting your brains with ideas and wondering how to
 implement them.
 So I designed this site to aid you along your journey, here you will find
 1. Advanced Course Material
 2. How To Video’s & Tutorials
 3. Tips & Tricks
 4. Access To All Blog Posts
 5. Access To Free Monthly Q&A Webinars – where i answer your questions.
 6. Discounts on All Training Webinars.
 7. New Content Added Constantly
 And much much more.......
 Visit My Support Site:
 www.YourInternetMarketingExpert.com/support
 CLICK HERE: To Download Your Free Resource Pack
 Filled With Tools To Aid Your Affiliate Campaign.



					
LOAD MORE                                    

            


            
                
                

                

                
                
                                

                                    
                        
                            
                                                            
                                                        

                        
                        
                            Amazon Affiliate Marketing | How To Start

                            Documents
                        

                    

                                    
                        
                            
                                                            
                                                        

                        
                        
                            Start-up Survival 101 @ Start-up Pirates Maastricht

                            Business
                        

                    

                                    
                        
                            
                                                            
                                                        

                        
                        
                            How to Kick-Start an Existing Affiliate Programme - Anna Checa, Affiliate Marketing Managerof LivingSocia

                            Presentations & Public Speaking
                        

                    

                                    
                        
                            
                                                            
                                                        

                        
                        
                            Start Me Up - tamos.nettamos.net/~bemo/horn-arrangements/books and hot... · Start Me Up If you start me up. If you start me up I'll never stop. If you start me up. If you start me

                            Documents
                        

                    

                                    
                        
                            
                                                            
                                                        

                        
                        
                            The Easiest Way To Start Making Money With Affiliate Marketing 2021

                            Small Business & Entrepreneurship
                        

                    

                                    
                        
                            
                                                            
                                                        

                        
                        
                            How to build up amazon affiliate product link

                            Data & Analytics
                        

                    

                                    
                        
                            
                                                            
                                                        

                        
                        
                            How to Start Affiliate Marketing Business

                            Business
                        

                    

                                    
                        
                            
                                                            
                                                        

                        
                        
                            Affiliate Start Guide - TradeTrackerstatic.tradetracker.net/.../affiliate/Affiliate-Start-Guide-en_GB.pdf · Affiliate Start Guide ... 13.3 EU cookie directive compliance ... Let’s

                            Documents
                        

                    

                                    
                        
                            
                                                            
                                                        

                        
                        
                            Kick start your start-up

                            Investor Relations
                        

                    

                                    
                        
                            
                                                            
                                                        

                        
                        
                            best way to Start affiliate marketing

                            Small Business & Entrepreneurship
                        

                    

                                    
                        
                            
                                                            

                                                        

                        
                        
                            The Best  Guide To Start  Affiliate Marketing

                            Small Business & Entrepreneurship
                        

                    

                                    
                        
                            
                                                            

                                                        

                        
                        
                            The Successful Affiliate Strategy some effort at the start, and consistently take the steps needed to build up your business, then frankly, you will not succeed. Learn More About Affiliate

                            Documents
                        

                    

                                    
                        
                            
                                                            

                                                        

                        
                        
                            How To Set Up And Maintain Affiliate Programsvideos.delavo.com/.../How_To_Set_Up_And_Maintain_Affiliate_Progra… · How To Set Up And Maintain Affiliate Programs 2. TABLE OF CONTENTS

                            Documents
                        

                    

                                    
                        
                            
                                                            

                                                        

                        
                        
                            How to start affiliate marketing

                            Technology
                        

                    

                                    
                        
                            
                                                            

                                                        

                        
                        
                            START-UP ACT- L'accélérateur CGEM-start-up

                            Business
                        

                    

                                    
                        
                            
                                                            

                                                        

                        
                        
                            Start up, Don! Start up! Научно-практическое пособие

                            Documents
                        

                    

                                    
                        
                            
                                                            

                                                        

                        
                        
                            The new guide to start affiliate marketing in NEURS

                            Business
                        

                    

                                    
                        
                            
                                                            

                                                        

                        
                        
                            How to Start an Affiliate Site (2017)

                            Marketing
                        

                    

                                    
                        
                            
                                                            

                                                        

                        
                        
                            What Is Affiliate Marketing  How To Get Started  Signing Up With Affiliate Networks  Affiliate Commission Types  Locating Hot Products and Markets

                            Documents
                        

                    

                                    
                        
                            
                                                            

                                                        

                        
                        
                            Setting Up An Art Affiliate Site - Part 2

                            Documents
                        

                    

                                    
                        
                            
                                                            

                                                        

                        
                        
                            AFFILIATE MARKETING · Turning into an affiliate marketer is a fantastic system for bloggers hoping to up their present salary or even to start bringing in cash from their blog. There

                            Documents
                        

                    

                                    
                        
                            
                                                            

                                                        

                        
                        
                            Geert Roete - start-up funding - start-up perspective

                            Small Business & Entrepreneurship
                        

                    

                                    
                        
                            
                                                            

                                                        

                        
                        
                            Start Up Loans The PR toolkit for start up

                            Documents
                        

                    

                                    
                        
                            
                                                            

                                                        

                        
                        
                            Affiliate Link Community User Quick Start Guideproviders.kaiserpermanente.org/info_assets/cpp_cod/...1 Affiliate Link Community User Quick Start Guide Reviewing the Patient Chart 2

                            Documents
                        

                    

                                    
                        
                            
                                                            

                                                        

                        
                        
                            How to Start an Affiliate Marketing Business - Secured Options

                            Business
                        

                    

                                    
                        
                            
                                                            

                                                        

                        
                        
                            HOW TO START A HOME BASED AFFILIATE BUSINESS ON THE INTERNET

                            Documents
                        

                    

                                    
                        
                            
                                                            

                                                        

                        
                        
                            Quick Start Guide 2020 AFFILIATE COMMISSION SECRETSaffiliatemarketinglessons.com/lm/a-quick-start-guide.pdf · “Affiliate Marketing Is One of the Quickest and Easiest Ways to Start

                            Documents
                        

                    

                                    
                        
                            
                                                            

                                                        

                        
                        
                            How to sign up Puzhen Affiliate Program?

                            Self Improvement
                        

                    

                                    
                        
                            
                                                            

                                                        

                        
                        
                            The best way to learn and start affiliate marketing

                            Small Business & Entrepreneurship
                        

                    

                                    
                        
                            
                                                            

                                                        

                        
                        
                            ACQUIRE - alexanderforbes.co.za · AFFILIATE 2 OUR AFFILIATE PROGRAMME. ASSOCIATE 3 OUR ASSOCIATE PROGRAMME. SUMMING UP OUR PROGRAMMES 1. ACQUIRE 2. AFFILIATE Partnering with IFAs

                            Documents
                        

                    

                                            

        

    


















    
        
            	About us
	Contact us
	Term
	DMCA
	Privacy Policy


            	English
	Français
	Español
	Deutsch



            
                

				STARTUP - SHARE TO SUCCESS

									
							
	


					

				            

        

    












	



